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How to Use This Book
Who This Book Is For
This book is for the reader who has never used this 
particular technology or software application. It is 
also for readers who want to expand their knowledge.

The Conventions in This Book
1  Steps

This book uses a step‐by‐step format to guide you 
easily through each task. Numbered steps are actions 
you must do; bulleted steps clarify a point, step, or 
optional feature; and indented steps give you the 
result.

2  Notes
Notes give additional information — special 
conditions that may occur during an operation, a 
situation that you want to avoid, or a cross reference 
to a related area of the book.

3  Icons and Buttons
Icons and buttons show you exactly what you need to 
click to perform a step.

4  Tips
Tips offer additional information, including warnings 
and shortcuts.

5  Bold
Bold type shows command names, options, and text 
or numbers you must type.

6  Italics
Italic type introduces and defines a new term.

1

2
3

4

5

6



Table of ContentsTable of Contents

Open Word .............................................................. 4

Explore the Word Window .......................................... 6

Work with Backstage View ......................................... 7

Change the Color Scheme .......................................... 8

Find a Ribbon Command ......................................... 10

Select Commands ................................................... 12

Using Word on a Tablet PC ...................................... 14

Work with the Mini Toolbar and Context Menus .......... 16

Enter Text ............................................................. 18

Move Around in a Document .................................... 20

 Chapter 1 Getting Familiar with Word

Save a Document ................................................... 24

Reopen an Unsaved Document ................................. 26

Save a Document in Word 97‐2003 Format ................. 28

Save a Document in PDF or XPS Format ..................... 29

Set Options for Saving Documents ............................ 30

Open a Word Document ........................................... 32

Open a Document of Another Format ........................ 34

Start a New Document ............................................ 36

Switch Between Open Documents ............................. 38

Compare Documents Side by Side ............................. 40

Inspect a Document Before Sharing .......................... 42

Work with Protected Documents ............................... 44

Mark a Document as Final ....................................... 46

Convert Word Documents from Prior Versions  
to Word 2016 ..................................................... 48

 Chapter 2 Managing Documents



Insert Text ............................................................ 52

Delete Text ........................................................... 54

Insert Blank Lines .................................................. 56

Undo Changes ....................................................... 57

Select Text ............................................................ 58

Mark and Find Your Place ........................................ 60

Move or Copy Text .................................................. 62

Share Text Between Documents ................................ 64

Move or Copy Several Selections ............................... 66

Take Advantage of Paste Options ............................. 68

Switch Document Views .......................................... 70

Understanding Document Views ............................... 71

Work with the Navigation Pane ................................ 72

Insert a Symbol ..................................................... 74

Work with Equations ............................................... 76

Zoom an Object ..................................................... 78

Zoom In or Out ...................................................... 80

Translate Text ....................................................... 81

Set Options for Additional Actions ............................ 82

Using Additional Actions ........................................ 83

 Chapter 3 Editing Text



Table of Contents

Change the Font ...................................................118

Change Text Size ..................................................119

Emphasize Information with Bold,  
Italic, or Underline ............................................120

Superscript or Subscript Text ..................................121

Change Text Case ..................................................122

Change Text Color .................................................123

Apply Text Effects .................................................124

Apply a Font Style Set ...........................................125

 Chapter 5 Formatting Text

Work in Read Mode View ......................................... 86

Search for Text ...................................................... 90

Substitute Text ...................................................... 92

Count Words in a Document ..................................... 94

Automatically Correct Mistakes ................................ 96

Automatically Insert Frequently Used Text ................. 98

Check Spelling and Grammar ...................................100

Disable Grammar and Spell Checking ........................102

Find a Synonym or Antonym with the Thesaurus ........104

Find a Definition ..................................................106

Track Document Changes During Review ...................107

Lock and Unlock Tracking .......................................108

Work with Comments .............................................110

Review Tracked Changes .........................................112

Combine Reviewers’ Comments ................................114

 Chapter 4 Proofreading



Change Text Alignment ..........................................134

Set Line Spacing Within a Paragraph ........................135

Set Line Spacing Between Paragraphs ......................136

Create a Bulleted or Numbered List ..........................138

Display Formatting Marks .......................................140

Hide or Display the Ruler .......................................141

Indent Paragraphs ................................................142

Set Tabs ..............................................................144

Add a Paragraph Border .........................................148

Review and Change Formatting ...............................150

Compare Formatting ..............................................152

Apply Formatting Using Styles ................................154

Switch Styles........................................................156

Save Formatting in a Style .....................................158

Expand or Collapse Document Content ......................160

Modify a Style ......................................................162

Add Paragraph Shading ..........................................163

 Chapter 6 Formatting Paragraphs

Apply Highlighting to Text .....................................126

Apply Strikethrough to Text ....................................127

Copy Text Formatting ............................................128

Remove Text Formatting ........................................129

Set the Default Font for All New Documents ..............130



Table of Contents

Adjust Margins .....................................................166

Insert a Page Break ...............................................168

Control Text Flow and Pagination ............................170

Align Text Vertically on the Page ............................172

Change Page Orientation ........................................173

Insert a Section Break ...........................................174

Add Page Numbers to a Document ...........................176

Add Line Numbers to a Document ............................178

Using the Building Blocks Organizer ........................180

Add a Header or Footer ..........................................182

Using Different Headers or Footers  
Within a Document ............................................184

Add a Footnote.....................................................186

Add an Endnote ....................................................187

Find, Edit, or Delete Footnotes or Endnotes ..............188

Convert Footnotes to Endnotes ...............................190

Generate a Table of Contents ..................................192

Add a Watermark ..................................................194

Add a Page Border ................................................196

Apply Document Formatting ...................................198

Create Newspaper Columns .....................................200

 Chapter 7 Formatting Pages



Preview and Print a Document ................................204

Print on Different Paper Sizes .................................206

Print an Envelope .................................................208

Set Up Labels to Print ...........................................210

 Chapter 8 Printing Documents

Create a Table ......................................................214

Change the Row Height or Column Width ..................216

Move a Table ........................................................218

Resize a Table ......................................................219

Add or Delete a Row ..............................................220

Add or Delete a Column .........................................222

Set Cell Margins ....................................................224

Add Space Between Cells ........................................225

Combine Cells .......................................................226

Split Cells ............................................................227

Split a Table.........................................................228

Add a Formula to a Table .......................................229

Align Text in Cells .................................................230

Add Shading to Cells .............................................231

Change Cell Borders ..............................................232

Format a Table .....................................................234

Add a Chart ..........................................................236

Chart Concepts .....................................................238

 Chapter 9 Working with Tables and Charts



Table of Contents

Control the Display of Formatting Marks ...................268

Customize the Status Bar .......................................269

Hide or Display Ribbon Buttons ...............................270

Add a Predefined Group to a Ribbon Tab ..................272

Create Your Own Ribbon Group ................................274

Create Your Own Ribbon Tab ...................................278

Work with the Quick Access Toolbar .........................282

Add Keyboard Shortcuts .........................................286

Create a Macro .....................................................288

Run a Macro .........................................................290

 Chapter 11 Customizing Word

Add WordArt ........................................................242

Add a Picture .......................................................244

Insert an Online Picture .........................................246

Insert an Online Video ...........................................248

Add a Screenshot ..................................................250

Add a Shape .........................................................252

Add a Text Box .....................................................254

Move or Resize a Graphic .......................................256

Understanding Graphics Modification Techniques .......258

Understanding Text Wrapping and Graphics ..............260

Wrap Text Around a Graphic ...................................261

Work with Diagrams ..............................................262

 Chapter 10 Working with Graphics



Create Letters to Mass Mail .....................................294

Create Labels for a Mass Mailing ..............................300

 Chapter 12 Working with Mass Mailing Tools

Email a Document .................................................308

Create a Hyperlink.................................................310

Post to Your Blog ..................................................312

Office and the Cloud ..............................................314

Sign In to Office 365 .............................................316

Open a Cloud Document .........................................318

Save a Document to the Cloud ................................320

Share a Document from Word ..................................322

Download Apps from the Office Store .......................324

Using the Word Online App in OneDrive ....................326

 Chapter 13 Word and the World Beyond Your Desktop

Index ..................................................... 328



CHAPTER  1

Getting Familiar 
with Word
Are you ready to get started in Word? In this chapter, you become 
familiar with the Word working environment, including the Word Start 
screen and Backstage view, and you learn basic ways to navigate and to 
enter text using both the keyboard and the mouse. You also learn some 
basics for using Word on a tablet PC.



Open Word.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   4

Explore the Word Window  . . . . . . . . . . . . . . . .  6

Work with Backstage View . . . . . . . . . . . . . . . .  7

Change the Color Scheme .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   8

Find a Ribbon Command . . . . . . . . . . . . . . . . . 10

Select Commands.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 12

Using Word on a Tablet PC . . . . . . . . . . . . . . . . 14

Work with the Mini Toolbar and Context Menus . . . . . . 16

Enter Text . . . . . . . . . . . . . . . . . . . . . . . . 18

Move Around in a Document  . . . . . . . . . . . . . . . 20



4

 A The Search menu appears.

Note: The Search menu displays 
popular news items from Bing, 
Microsoft’s search engine. You can use 
the buttons on the left side of the 
Search menu to, for example, establish 
search settings for Cortana, the 
Windows Search assistant.

1 Click in the search box.

Open Word

Office 2016 runs on a 1 gigahertz (GHz) or faster x86‐ or x64‐bit processor with 1 or 2 gigabytes 
(GB) of RAM, based on your processor speed, and your system must be running Windows 7, 

Windows 8, Windows 10, Windows Server 2008 R2, or Windows Server 2012.

This section demonstrates how to open Word from Windows 10. After Word opens, the Word Start 
screen appears, helping you to find a document on which you recently worked or starting a new 
document. For other ways to open or start a new document, see Chapter 2.

Open Word
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2 Start typing the name of the 
program; for this example, type word.

 B A list of choices appears that match 
the letters you typed.

3 Click the choice matching the 
program you want to open.

TIP
Can I create a shortcut to open an Office application?
You can, but pinning the program to the Windows taskbar or Start menu is easier. 
Follow Steps 1 and 2 in this section. Then, right‐click the program name in the 
list. From the menu that appears, click Pin to taskbar or Pin to Start. Windows 
10 pins the program to the Windows taskbar or the Start menu. To open the 
program, click the program’s button on the taskbar or Start menu. Programs 
pinned to the Start menu appear on the right side of the menu as tiles.

The program opens and displays its 
Start screen, which helps you open new 
or existing documents; see Chapter 2 
for other ways to open documents.

 C You can use this panel to open an 
existing document.

 D You can click a thumbnail in this area 
to start a new document.

 E This area indicates whether you have 
signed in to your Office 365 
subscription, which enables you to 
work on your documents from 
anywhere.

Note: See Chapter 13 for details about 
signing in to Office 365.

 F To exit from the program, you can 
click the Close button ( ).



6

Explore the Word Window

All Office programs share a common appearance and many features, and Word is no different. 
These features include a Ribbon and a Quick Access Toolbar (QAT). The Ribbon contains most 

commands available in Word, and the QAT contains frequently used commands.

  A Quick Access 
Toolbar (QAT)
Contains buttons that 
perform common actions. 
To customize the QAT, see 
Chapter 11.

  B Ribbon
Contains buttons 
organized in tabs, groups, 
and commands.

  C Dialog Box 
Launcher
Appears in the lower right 
corner of many groups on 
the Ribbon. Clicking this 
button ( ) opens a 
dialog box or task pane 
that provides more options.

  D Document Area
The area where you type. The 
flashing vertical bar, called the 
insertion point, represents the 
location where text will appear 
when you type.

  E Status Bar
Displays document information and 
the location of the insertion point. 
From left to right, this bar contains 
the number of the page on which 
the insertion point currently 
appears, the total number of pages 
and words in the document, and 
the Proofing Errors button ( ).

F View Shortcuts
Contains buttons to switch to a 
different view of your document.

G Zoom Controls
Changes the magnification of a 
document.

H Office 365 Indicator
If your name appears, you are 
signed in to your Office 365 
subscription. You can click  to 
display a menu that enables you 
to manage your Microsoft account 
settings. If you are not signed in, 
this area shows a Sign In link. 
See Chapter 13 for details about 
signing in to Office 365.

I Program Window Controls
These buttons enable you to 
control the appearance of the 
program window. You can 
minimize the Ribbon, and you can 
minimize, maximize, restore, or 
close the program window.

J Title Bar
Shows the document and program 
titles.
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 A Commonly used file and program 
management commands appear 
here.

 B Buttons representing places you 
commonly use to open 
documents appear here.

 C Information related to the 
button you click appears here. 
Each time you click a button 
in the Open column, the 
information shown to the right 
changes.

Note: The New, Close, and Options 
commands behave differently; when 
you click any of them, Word takes 
the action you chose. For example, 
clicking Close closes the current 
document.

2 Click the Back button ( ) to 
redisplay the open document.

1 Click the File tab to display 
Backstage view.

Work with Backstage View

Work with Backstage View

You can click the File tab to display Backstage view. Backstage is the place to go when you need 
to manage documents or change program behavior. In Backstage view, you find a list of actions 

that you can use to open, save, print, remove sensitive information, and distribute documents as 
well as set Word program behavior options. You can also use Backstage to manage the places on your 
computer hard drive, in your network, or in your OneDrive space that you use to store documents.
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2 Click Account.

3 Click the Office Theme .

4 Click an Office theme.

Note: Make sure you are signed in to 
Office 365. See Chapter 13 for details.

1 Click File to open Backstage view.

Change the Color Scheme

You can use Office themes and background patterns to change the appearance of the program 
screen. Themes control the color scheme the program uses, and background patterns can add 

interest to the screen while you work. Color schemes can improve your ability to clearly see the 
screen, but be aware that background patterns might be distracting.

Office themes are available even if you are not signed in to Office 365, but to use background 
patterns, you must sign in to Office 365. For details on how to sign in and out of Office 365, see 
Chapter 13.

Change the Color Scheme
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The Office theme and background 
you selected appear.

 B The background appears in the title 
bar and the tabs of the Ribbon.

The colors of your program change.

Note: Some theme changes are more 
subtle than others.

5 Click the Office Background .

6 Point the mouse ( ) at a choice in 
the menu to highlight that choice.

 A A background pattern appears at the 
top of the window. The pattern 
remains as you work on documents.

7 Click the pattern you want to use or 
click No Background.

8 Click the Back button ( ) to return 
to your document.

TIP
What happens if I select an Office background and then sign out of Office 365?
The background no longer appears in the program, but will reappear when you next sign in to Office 365. 
Similarly, theme changes you make while signed in to Office 365 might disappear when you sign out of 
Office 365. With themes, however, you do not need to be signed in to Office 365 to make a selection. Just 
complete Steps 1 to 4.
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 A A list of commonly requested actions 
appears.

1 Open a document.

Note: See Chapter 2 for details on 
opening documents.

2 Click here.

Find a Ribbon Command

When you need to take an action that you do not take on a regular basis, you can use Word 
2016’s new feature, the Tell Me What You Want To Do feature. The Tell Me What You Want To Do 

search feature helps you find commands on the Ribbon.

You can still use the Ribbon directly, as described in the next section, “Select Commands.” The Tell 
Me What You Want To Do search feature is most useful when you are not sure where on the Ribbon to 
find the command you need.

Find a Ribbon Command
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 D The program performs the action you 
selected; in this example, Word 
places a border around the first 
paragraph of the document.

3 Type a brief description of the action 
you want to take.

 B The program lists possible commands 
you can use to complete your task.

4 Click a command to use it.

 C If you click a command that displays 
this arrow ( ), additional options 
appear.

TIPS
Will I need to type a description of the action 
I want to take if it is the same action I have 
previously taken?
No. The Tell Me What You Want To Do search box 
remembers your previous searches and displays them 
on the menu that appears when you perform Step 2.

If I no longer want my previous searches to 
appear, can I clear them from the list?
No. The Tell Me What You Want To Do feature 
retains your searches in the Recently Used section 
of the menu that appears when you click in the 
search box.
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Select Commands with the Keyboard
1 If appropriate for the command you 

intend to use, place the insertion point 
in the proper word or paragraph.

2 Press  on the keyboard.

 A Shortcut letters and numbers appear on 
the Ribbon.

Note: The numbers control commands on 
the Quick Access Toolbar.

3 Press a letter to select a tab on the 
Ribbon.

This example uses .

Select Commands

You can keep your hands on your keyboard and select commands from the Ribbon or the Quick 
Access Toolbar (QAT), or you can use the mouse.

The Ribbon contains buttons organized in tabs, groups, and commands. Tabs appear across the top of 
the Ribbon and contain groups of related commands. Groups organize related commands; the group 
name appears below the group. Commands appear within each group. The QAT appears above the 
Ribbon and by default contains the Save, Undo, and Redo commands. To customize the Ribbon or the 
QAT, see Chapter 11.

Select Commands

Word displays the appropriate tab and 
letters for each command on that tab.

4 Press a letter or letters to select a 
command.

If appropriate, Word displays options 
for the command you selected. Press 
a letter or use the arrow keys on the 
keyboard to select an option.

Word performs the command you 
selected, applying the option you chose.
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 C Word performs the command you 
selected.

Note: If you selected text, click 
anywhere outside the text to continue 
working.

Select Commands with the Mouse
1 Click in the text or paragraph you 

want to modify.

Note: If appropriate, select the text; see 
Chapter 3 for details.

2 Click the tab containing the 
command you want to use.

3 Point to the command you want 
to use.

 B Word displays a ScreenTip describing 
the function of the button at which 
the mouse ( ) points.

4 Click the command.

TIPS
Can I toggle between the document 
and the Ribbon using the keyboard?
Yes. Each time you press , Word 
changes the focus of the program, 
switching between the document, the 
status bar, and the Ribbon, in that order.

What do the small down arrows below or beside buttons mean?
The small arrow ( ) on a button means several choices are 
available. Click the button directly to apply a default choice. 
Click  to view additional options. As you move the mouse ( ) 
over the two parts of the button, Word highlights one or the 
other to alert you that you have more choices.
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 D An alphabetical list of programs 
installed on your computer appears.

3 Scroll through the list and tap 
Word 2016 to open Word to the 
Word Start screen.

Start a Program
1 Tap the Windows Start button ( ).

 A The Windows 10 Start menu appears.

 B Program tiles appear on the 
right side.

 C If the program you want to open 
appears in the Most Used list, you 
can tap it to open it. Or you can 
scroll through the program tiles on 
the right to find and tap the 
program you want to open.

2 Tap All apps.

Using Word on a Tablet PC

Using Word 2016 on a tablet offers a different experience than using the program on a computer 
with a keyboard and mouse. This section shows you how to open Word on a touch device and 

how to switch between Touch and Mouse modes.

Enhancements for tablets are limited primarily to enlarging buttons on the status bar, the Quick 
Access Toolbar, and the Ribbon to make selecting commands easier. For a friendlier touch experience, 
consider using the universal Word app for various mobile devices, which, although not as powerful as 
Word 2016, were written specifically for touch devices. You can share documents across platforms.

Using Word on a Tablet PC
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CHAPTER

1Getting Familiar with Word

Using Touch/Mouse Mode
1 Tap the Customize Quick 

Access Toolbar .

2 Tap Touch/Mouse Mode.

 E Word adds the Touch/Mouse 
Mode button to the Quick 
Access Toolbar.

Note: By default, each Office 
program displays the screen in 
Mouse mode.

 F In Mouse mode, buttons on the 
Quick Access Toolbar and the 
Ribbon are smaller.

3 Tap Touch/Mouse Mode.

 G A drop‐down menu appears.

4 Tap Touch.

 H The program enlarges the size 
of buttons on the Quick Access 
Toolbar and the Ribbon, 
grouping Ribbon buttons as 
needed.

 I The status bar, view buttons, 
and zoom slider also appear 
larger.

TIP
Are there any other features in Word 2016 that make the program easier to 
use on touch devices?
Yes, Word’s Read Mode contains buttons on the left and right sides of the 
screen (  and ) ( A ) that you can tap to change pages. See Chapter 4 for 
details. For a more touch‐friendly experience, consider using the universal app 
Word, available in the Microsoft Store, on an iPad or Android device.
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 B Word performs the action on the 
selected text, leaving the Mini 
Toolbar visible so that you can use 
it again if you want.

Work with the Mini Toolbar
1 Select text.

 A The Mini Toolbar appears.

Note: If you slowly slide the mouse ( ) 
away from the selected text, the Mini 
Toolbar becomes transparent and then 
disappears.

2 Click any command or button to 
perform the actions associated with 
the command or button.

Work with the Mini Toolbar and Context Menus

Most of the formatting commands appear on the Home tab in Word, but you have alternatives to 
format text. Without switching to the Home tab, you can format text using the Mini Toolbar, 

which contains a combination of commands available primarily in the Font and the Paragraph groups 
on the Home tab.

You also can use the context menu to format text without switching to the Home tab or the Review 
tab. The context menu contains the Mini Toolbar and a combination of commands available primarily 
in the Font group and the Paragraph group on the Home tab and on the Review tab.

Work with the Mini Toolbar and Context Menus


